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Abstract- This research paper has a primary objective of
developing standardized descriptions and practices for
smart home devices that are employed in demand response
and load management applications within residential or
light commercial settings. The initial version of the research
paper specifically concentrates on control application
domains like sensing device control, pricing and demand
response, as well as load control. The paper also introduces
smart home interfaces and device definitions that play a
crucial role in promoting interoperability among various
manufacturers of electrical equipment, meters, and smart
energy enabling products. By establishing these
standardized descriptions and practices, the research paper
aims to enhance the compatibility and seamless integration
of smart home devices, ultimately leading to more efficient
and effective demand response and load management in the
context of smart homes.

INTRODUCTION

loT-Based Smart Load Management is a sophisticated
system that harnesses the power of the 10T (Internet of
Things) to effectively control and monitor energy load
within a specific area. Its primary objective is to enhance
energy efficiency, reduce energy costs, ensure higher
reliability, and promote overall safety. By leveraging an
interconnected network of sensors, actuators, and other
intelligent devices, this system can actively detect,
analyze, and regulate energy consumption patterns,
leading to optimized energy usage and minimized
wastage. Moreover, it enables real-time data acquisition
and analysis for efficient energy management and
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optimization. In industrial applications, the proposed
system showcases its capabilities by seamlessly
integrating loT  technologies, advanced sensor
mechanisms, and data analytics to continuously monitor
and manage power consumption. It proactively identifies
any anomalies or irregularities in power usage, allowing
for timely notifications and alerts to the concerned user or
operator. Through its comprehensive approach to load
management, the loT-Based Smart Load Management
system promises to revolutionize energy utilization
practices and pave the way for a more sustainable and
resource-efficient future.
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Fig: Block Diagram of 10T Based smart load management
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EXISTING SYSTEM

The current system for smart load management heavily
relies on manual processes, where users are responsible
for manually monitoring and controlling their power
consumption. This manual approach is not only
inefficient but also susceptible to human errors, leading to
suboptimal energy management. Moreover, the lack of
automated monitoring and analysis means that users have
no means to detect irregularities in power usage or receive
valuable insights and recommendations on how to
optimize their energy consumption. This limitation
further hinders the ability to achieve energy efficiency
goals and make informed decisions regarding power
usage. A more advanced and automated smart load
management system is needed to address these drawbacks
and enable users to efficiently monitor, control, and
optimize their power usage while minimizing human
error and gaining valuable insights for energy
optimization.

DISADVANTAGES:

e The system is employed with a wired
connection.

e The reason for using wired communication is to
replace existing wired systems.

e Implementing a wired system requires careful
planning and construction work to ensure
efficiency and a clean design.

e The use of a wired connection introduces
hardware complexity into the system.

PROPOSED SYSTEM

The proposed smart load management system is an 10T-
based solution that leverages sensors and data analytics to
effectively monitor and control power usage specifically
in industrial applications. By utilizing a network of
sensors, the system can accurately detect any anomalies
or deviations in power consumption, promptly alerting
the user or operator to potential issues. Additionally, the
system goes beyond anomaly detection and offers
valuable insights and recommendations on how to
optimize power usage. This enables users to make
informed decisions and implement energy-efficient
practices, ultimately improving energy management and
reducing costs. With its advanced capabilities, the
proposed system aims to enhance operational efficiency
and sustainability in industrial settings by providing real-
time monitoring, proactive alerts, and actionable
recommendations for optimizing power usage.

Advantages

e Energy Efficiency is improved

e Lower Energy Costs

Increased Reliability

Increased Safety
HARDWARE COMPONENTS
e Nodemcu
e CT (Current Transformer)
e PT(Potential Transformer)
e Relay Board
o Bulbs(2)

Software Requirement

e Arduino IDE
«  Embedded-C
« 0T

LITERATURE SURVEY

“A survey on smart metering and smart grid
communication, Renewable and Sustainable Energy
Reviews”:

This research focuses on the extensive study of smart
communication and metering methods within the context
of smart grids. It highlights that while control and
monitoring processes are commonly used in industrial
systems. The evolution of smart grids is driven by energy
management requirements of both service providers and
consumers. The paper aims to provide a clear
understanding of what smart grids are and the various
communication methods utilized within them.

"Hybrid nanogrids development to improve residential
reliability and resiliency supply: Testing and
implementation, Tropical Renewable Energy Center,
Universitas Indonesia™:

This paper proposes a novel concept called "Dual Power
Nanogrids" as a solution improving the reliability and
resiliency of power supply for residential sectors,
particularly relevant during the COVID-19 pandemic
when most activities are conducted at home. It divides the
voltage into two parts: DC voltage and AC voltage,
supplied through a 230 VAC inverter for motor/inductive
loads.

"A survey on smart grid technologies and applications,
Journal of King Saud University - Computer and
Information Sciences™:

This survey paper explores various aspects of smart grid
technologies and applications. It highlights that a smart-
grid, an advanced digital power system capable of two-
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way power flow, self-healing, adaptability, resilience, and
sustainability. The paper covers topics such as enabling
smart grid metering and communication in technologies,
cloud computing in smart grids, and smart grid
applications.

"Grid-Tied Distributed Generation Systems to Sustain the
Smart Grid Transformation: Tariff Analysis and
Generation Sharing, Frontiers in Energy Research -
Electrical Applications':

This paper introduces a novel model that has been
proposed and analyzed by ENEL, the largest electric
utility in Chile. The model specifically addresses electric
power control and energy management for a residential
building comprising 60 apartments. This case study
serves as an exemplification of ENEL's green energy
program, which is an integral part of their Smart Grid
Transformation plan. The plan entails the implementation
of grid-tied distributed generation (DG) systems,
particularly microgrids, equipped with solar generation
and energy storage technologies in Santiago, Chile. By
presenting this model and case study, the paper highlights
the utility's commitment to sustainable energy practices
and showcases the potential of smart grid technologies in
optimizing energy management at the residential level.

Hardware module

Nodemcu

The ESP32s module is a versatile and affordable device
designed to facilitate internet connectivity for various
projects. It offers the flexibility of operating as either an
access point, enabling the creation of a local network, or
as a station, allowing connection to existing Wi-Fi
networks. This functionality enables the module to fetch
data from the internet and upload data from connected
devices, making it a valuable component in Internet of
Things (loT) applications. Additionally, the module
supports communication with APls, enabling access to a
wide range of information available on the internet.
Notably, the ESP32s module can be conveniently
programmed using the Arduino IDE, providing a user-
friendly development environment. It is worth
mentioning that while this version of the module has two
GPIO pins (expandable to four with certain
modifications), it can be used in conjunction with other
microcontrollers, such as Arduino, or standalone versions
of the ESP-12 or ESP-32 for projects requiring more
GPIO pins. Overall, the ESP32s module offers an
accessible and efficient solution for initiating 10T projects
or adding internet connectivity to existing projects. This
versatility enables easy data retrieval and uploading to the
internet, making it ideal for Internet of Things (loT)

applications. The module can also fetch data from the
internet using APIs, expanding the range of available
information for your project. Another notable feature is
its compatibility with the Arduino IDE, simplifying the
programming process. However, it is important to note
that this version of the module has only 2 GPIO pins,
although it can be modified to utilize up to 4 pins. If more
GPIO pins are required, alternative versions such as ESP-
12 or ESP-32 may be considered. Overall, the ESP32s
module is a suitable choice for beginners in 10T or
projects requiring internet connectivity.

Current Transformer

A current transformer (CT) is an electrical transformer
used for measuring or monitoring electric current flowing
through a conductor. It plays a crucial role in electrical
power systems, serving various applications including
protection, control, metering, and monitoring. CTs are
designed for specific current ratings and accuracy classes
based on their intended purpose. They are commonly
employed in high-voltage electrical systems, such as
power substations and distribution networks, to provide
precise current measurements for protection relays,
energy meters, and other monitoring devices.
Additionally, CTs find application in industrial and
commercial settings to measure current in motor control
circuits, HVAC systems, and other electrical equipment.
Key characteristics of current transformers include
accuracy, burden rating (indicating the maximum load
connected to the secondary winding without affecting
measurement accuracy), and saturation characteristics
(the point at which nonlinear behavior occurs due to
excessive current). They are engineered to operate safely
and efficiently under normal and fault conditions,
adhering to industry standards and regulations to ensure
reliability and performance

Potential transformer:

Potential transformers (PTs) are indeed used to step down
high voltage levels to a lower, measurable level that is
safe for use with standard metering or monitoring
equipment. Here are some additional points regarding
potential transformers: PTs are commonly utilized in
high-voltage electrical systems, such as power substations
and distribution networks, where accurate voltage
measurements are essential for protection relays, energy
meters, and other monitoring devices.They also find
application in industrial and commercial settings to
measure voltage in various electrical equipment and
systems.Similar to current transformers, potential
transformers are designed for specific voltage ratings and
accuracy classes, depending on their intended
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purpose.PTs are engineered to provide accurate voltage
measurements with minimal phase shift, ensuring the
reliability and precision of the measured values even
under varying load conditions. They comply with industry
standards and regulations to guarantee their performance,
safety, and compatibility with other electrical components
and systems.By employing potential transformers in
electrical power systems, high voltage levels can be safely
and accurately measured, enabling effective monitoring,
protection, and metering operations.

Relay

Relays operate by utilizing the principles of
electromagnetic attraction. When a fault current is
detected in a circuit, the relay's electromagnetic field is
activated, producing a temporary magnetic field. This
magnetic field exerts a force on the relay's armature,
causing it to move and either establish or break the
electrical connections within the relay. In the case of a
small power relay, it typically consists of a single contact
that is responsible for opening or closing the switch. On
the other hand, high-power relays often feature two
contacts for enhanced switching capabilities. Internally,
the relay comprises an iron core that is wound with a
control coil. The control coil receives power through the
contacts of the load and the control switch. When an
electric current passes through the control coil, it
generates a magnetic field around the coil. As a result of
this magnetic field, the upper arm of the relay's magnet
attracts the lower arm, bringing them together and closing
the circuit. This allows the current to flow through the
load, enabling the intended operation. Conversely, if the
contacts are already closed, the magnetic field causes the
armature to move in the opposite direction, opening the
contacts and interrupting the current flow. By utilizing
this electromagnetic attraction principle, relays provide a
reliable means of controlling electrical circuits and
enabling or disabling the flow of current based on specific
conditions or signals.

Software module

Arduino Software (IDE)

The Arduino Integrated Development Environment
(IDE), also known as Arduino Software (IDE), is a
powerful software platform designed for writing and
uploading code to Arduino and Genuino boards. It offers
a range of tools and features that facilitate the entire
development process. In previous versions of the Arduino
IDE, sketches were saved with the .pde file extension.
However, starting from version 1.0, sketches are saved
with the .ino extension. If you open a .pde file using
version 1.0 or later, the IDE will prompt you to save the

sketch with the .ino extension when you save the file. The
Arduino IDE provides a user-friendly and intuitive
interface that simplifies the coding experience. It includes
a text editor for writing code, a message area for
displaying feedback and error messages, a text console for
displaying program output, a toolbar with common
functions, and a series of menus for accessing various
features. One of the key features of the Arduino IDE is its
ability to compile and upload code to Arduino boards. It
supports a wide range of Arduino and Genuino boards,
allowing you to select the appropriate board from the
Tools menu. Additionally, you can choose the correct port
from the Tools menu to establish a connection between
the IDE and the board. The Arduino IDE is designed to
be beginner-friendly while still providing advanced
functionality for experienced users. It offers a simplified
programming language based on C/C++, making it
accessible to those who are new to programming.
Furthermore, it provides a vast library of pre-written code
examples and tutorials, enabling users to learn and
experiment with different functionalities. Overall, the
Arduino IDE serves as a comprehensive and efficient
platform for writing, compiling, and uploading code to
Arduino boards. Its user-friendly interface and extensive
features make it a popular choice among both beginners
and experienced Arduino enthusiasts.

Sketchbook

The Arduino Software (IDE) uses the concept of a
sketchbook: a standard place to store your programs (or
sketches). The Arduino Software (IDE) implements the
concept of a sketchbook, which serves as a designated
location for storing your Arduino programs or sketches.
This allows for easy organization and management of
your projects. When you launch the Arduino IDE for the
first time, it automatically creates a directory on your
computer to serve as your sketchbook. This directory acts
as a container for all your sketches. By default, the
sketchbook directory is located in the user's Documents
folder. To access the sketches within your sketchbook,
you can go to the File menu and select Sketchbook. This
will display a list of all the sketches present in your
sketchbook directory. Additionally, you can use the Open
button on the toolbar to browse and open sketches directly
from your sketchbook. If you wish to change the location
of your sketchbook directory, you can do so by accessing
the Preferences dialog. In the Arduino IDE, go to File >
Preferences. This will open the Preferences dialog where
you can view and modify various settings related to the
IDE. Within the Preferences dialog, you will find an
option to specify the location of your sketchbook. By
default, it points to the previously mentioned sketchbook
directory. Changing the sketchbook location can be useful
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if you prefer to store your sketches in a different directory
or if you want to keep your sketches synchronized across
multiple devices. By providing a dedicated sketchbook,
the Arduino IDE makes it easy to manage and organize
your projects, allowing for convenient access to your
sketches and providing a streamlined workflow for
Arduino development.

Uploading

To upload your sketch to the Arduino board using the
Arduino IDE, you need to ensure that your Arduino board
is connected to your computer via a USB cable. Once you
have your sketch ready, open it in the Arduino IDE. From
the toolbar, click on the upload button or go to the Sketch
menu and select "Upload™. The Arduino IDE will compile
your sketch and initiate the upload process. If you're using
a newer Arduino board, it will reset automatically before
the upload begins, and you'll notice the RX and TX LEDs
blinking on the board. However, for older boards without
auto-reset, you'll need to manually press the reset button
on the board just before starting the upload. The Arduino
IDE will display the upload progress, and once it's
complete, you'll see a "Upload complete” message. In
case of any issues, such as connection problems or
compilation errors, the Arduino IDE will display an error
message for you to troubleshoot. By following these
steps, you can easily upload your sketch to the Arduino
board and begin running your code.

Embedded C

Embedded C is a highly versatile and robust
programming language that is specifically designed for
embedded systems development. It offers a wide range of
features and capabilities that make it a popular choice
among developers working on microcontrollers and other
embedded devices. One of the key advantages of
Embedded C is its ability to provide low-level access to
hardware resources, allowing developers to directly
control and interact with the underlying components of
the system. This level of control enables efficient
utilization of system resources and enables developers to
implement custom functionalities tailored to the specific
requirements of the embedded system. Another important
feature of Embedded C is its emphasis on efficient code
execution. Embedded systems often operate with limited
processing power and memory resources, and the ability
to write optimized code is crucial for achieving high
performance and responsiveness. Embedded C provides
various mechanisms and techniques for code
optimization, such as inline assembly, register
manipulation, and memory management, which
contribute to the overall efficiency of the system.

Furthermore, Embedded C offers a compact and concise
syntax, resulting in smaller memory footprint and reduced
code size. This is particularly valuable in embedded
systems where space constraints are common. Despite its
compactness, Embedded C provides rich functionality
and supports various programming paradigms, allowing
developers to implement complex algorithms and logic.
As the demand for embedded systems continues to grow
in industries such as automotive, aerospace, consumer
electronics, and industrial automation, the significance of
Embedded C as a powerful programming language for
developing efficient and reliable embedded systems is
expected to persist. Its unique combination of low-level
access, efficient code execution, and compactness makes
it a valuable tool in the ever-evolving field of embedded
systems development.

ThingSpeak

ThingSpeak is an 10T platform that offers a range of
features to connect, store, and analyze sensor data in the
cloud, enabling the development of loT applications. The
platform provides a variety of tools and applications for
data analysis and visualization, while also offering
MATLAB support for advanced data processing. With
ThingSpeak, sensor data can be easily integrated and
transmitted from devices like Arduino, Raspberry Pi, or
any other loT gateway. Key features of ThingSpeak
include the ability to collect data in private channels,
allowing users to keep their data secure and accessible
only to authorized individuals or systems. Additionally,
data can be shared using public channels, enabling
collaboration and data sharing with a wider audience.
ThingSpeak supports both REST APl and MQTT APIs,
providing flexible options for data integration and
communication with the platform. The REST API allows
for programmatic access to ThingSpeak, facilitating data
retrieval, storage, and manipulation. The MQTT API
enables lightweight and efficient data exchange between
loT devices and the platform. The integration of
MATLAB with ThingSpeak enhances the platform's
capabilities by enabling advanced analytics and
visualizations. MATLAB is a powerful programming and
analysis environment that allows users to perform
complex calculations, apply machine learning algorithms,
and generate insightful visual representations of the data.

ThingSpeak also benefits from its worldwide community,
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which fosters collaboration, knowledge sharing, and the
development of innovative loT applications. The
community provides a platform for users to exchange
ideas, seek assistance, and share their experiences and
projects. Overall, ThingSpeak offers a comprehensive
loT platform with features such as data collection,
sharing, REST APl and MQTT API support, MATLAB
analytics, and a thriving worldwide community. These
features make it a versatile and robust platform for
connecting, analyzing, and acting upon sensor data in the

context of loT applications.

RESULT

Fig: Thinkspeak with MATLAB
MQTT (Message Queuing Telemetry Transport)

MQTT (Message Queuing Telemetry Transport) is a
widely adopted protocol in the realm of Internet of Things
(loT). It provides a lightweight and efficient
communication mechanism for resource-constrained loT

devices. Here are some key points about MQTT:

Publish-Subscribe Model: MQTT follows a publish-
subscribe model, where 10T devices publish information
(messages) on specific topics, and other devices (clients)

can subscribe to those topics to receive the published data.

MQTT Broker: A central component in MQTT is the
MQTT broker, which acts as an intermediary between
publishers and subscribers. It receives messages from
publishers and forwards them to the appropriate

subscribers based on their subscriptions.

Topics: Topics in MQTT represent a hierarchical

structure, similar to file paths. Each topic acts as a channel

or category to which messages can be published. Clients
can subscribe to specific topics or use wildcards to

subscribe to multiple levels of the topic hierarchy.

QoS (Quality of Service): MQTT supports different levels
of Quality of Service for message delivery. QoS levels
range from 0 to 2, offering varying degrees of reliability

and guarantee of message delivery.

Lightweight and Efficient: MQTT is designed to be
lightweight, making it suitable for resource-constrained
devices with limited processing power, memory, and
bandwidth. It uses a small network footprint, minimizing

the impact on network traffic and conserving energy.

Scalability and Flexibility: MQTT enables seamless
communication between a large number of devices,
making it highly scalable. It also provides flexibility in
terms of data exchange, allowing devices to communicate
in a publish-subscribe manner rather than establishing

direct connections.

Standardized Protocol: MQTT is an open and
standardized protocol, maintained by the Organization for
the Advancement of Structured Information Standards
(OASIS). It has broad industry support and is

implemented in various loT platforms and devices.

With its simplicity, efficiency, and suitability for
resource-constrained devices, MQTT has become a
prevalent choice for loT applications. It facilitates
efficient data exchange, real-time communication, and
effective management of IoT ecosystems, making it an

integral part of the loT landscape.

Broker

The MQTT broker plays a crucial role in the MQTT
publish/subscribe protocol. It acts as a central hub that
facilitates communication between MQTT clients. The
broker receives messages from publishers and ensures
that they are delivered to the intended subscribers. It

handles the task of filtering messages based on
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subscription topics and identifying which clients have
subscribed to specific topics. This allows for efficient and
targeted message distribution, enabling effective
communication in large-scale MQTT deployments with
numerous concurrently connected clients. With its
ability to handle thousands of connected clients
simultaneously, the MQTT broker provides scalability
and flexibility in loT applications. It serves as a reliable
and robust intermediary, managing the flow of messages
between publishers and subscribers. The broker's
performance is crucial for ensuring real-time and reliable
communication within an MQTT network. By efficiently
routing and delivering messages, the broker enables
seamless data exchange and synchronization between
devices and applications. Furthermore, MQTT brokers
often support advanced features such as message
persistence, security mechanisms, and QoS (Quality of
Service) levels. They can provide storage and buffering
capabilities for messages, ensuring reliable delivery even
in cases of temporary network disruptions. Security
measures such as authentication and access control can
be implemented at the broker level, ensuring secure and
authenticated = communication  between clients.
Additionally, brokers allow for different QoS levels to be
configured, enabling trade-offs between message
delivery guarantees and network bandwidth utilization.
Overall, the MQTT broker is a critical component in
MQTT-based loT systems, enabling efficient and reliable
communication between connected devices. Its ability to
handle concurrent connections, filter messages, and
route them to the appropriate subscribers ensures

seamless data exchange and facilitates the development

of scalable and robust loT applications.

Advantages

o Efficient data transmission and quick
implementation due to MQTT's lightweight

nature.

e Low network usage thanks to minimized data
packets, optimizing bandwidth utilization.

o Efficient distribution of data through MQTT's
publish/subscribe model, ensuring selective
delivery to subscribed clients.

e Successful implementation of remote sensing and
control applications.

e Fast and efficient message delivery, enabling
real-time communication between devices.

e Usage of small amounts of power, making it

suitable for energy-constrained devices.

e Reduction of network bandwidth, enhancing

overall system performance and scalability.

CONCLUSION

» The project concludes that IoT-based smart device
management developed and used to monitor and control

energy consumption.

* The system can detect anomalies in power consumption

and alert the user.

* It can also provide insights and recommendations 0On

how to improve energy efficiency.
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